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Microsoft Excel adalah aplikasi yang digunakan untuk mengolah data. Yang memiliki banyak
kemampuan antara lain mengolah data tabel, pembuatan grafik, pembuatan diagram,
penghitungan atau kalkulasi, penggunaan operasi rumus dan fungsi, penyaringan data dan

lain sebagainya. Selain itu Microsoft Excel juga dapat mengolah data statistic dan
menganalisanya.

Microsoft Excel terbaru adalah Microsoft Excel 2016 , aplikasi ini berorientasi pada kebutuhan
pemakai dan menyediakan berbagai alat canggih yang dapat Anda gunakan untuk
menganalisa, berbagi/share dan mengatur data dengan mudabh.

Memulai Microsoft Excel

Gambar 1 : Memulai Micrososft Excel

Keterangan: p—
1. Klik Start Menu e ) » Klik Program » Klik Microsoft Office » klik Microsoft Excel

2016
2. Atau klik dua kali pada Shortcut ( \ ) Excel jika terdapat pada desktop Anda.

3 | Modul Microsoft Excel



S5 Lenbarkes Moowc

Menu Pada Microsoft Excel

Tool Bar

Menu Bar
» Ribbon
» Formula Bar

> Cell Pointer

u » Worksheet

Gambar 2 : Lembar kerja Micrososft Excel

Keterangan:

1. Ribbon : sebuah menu baru yang menggantikan system menu lama. Dalam ribbon Anda
cukup memilih tab-tab yang disediakan pada saat memasuki sebuah menu, misalnya di
dalam menu Home terdapat tab-tab Clipboard, Slides, Font, Paragraph, Drawing dan lain
sebagainya. Dengan menggunakan ribbon Anda dapat dengan mudah mencari dan
menggunakan perintah-perintah yang ingin Anda gunakan tanpa perlu keluar masuk

menu dan sub menu seperti Powerpoint terdahulu.
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2. Toolbar, adalah sekumpulan tool-tool atau perintah yang sering Anda gunakan,
contohnya New, Open, Print, Print Preview dan lain sebagainya. Anda dapat menambah atau
mengurangi tool-tool yang terdapat di Quick Acces Toolbar tersebut.

3. Menu Bar
adalah Menu yang merupakan bagian dari ribbon, yang didalamnya terdapat tab-tab
perintah untuk pengaturan dokumen seperti Home, Insert, Design, Layout, References,
Mailings, Review, View. Selain itu nantinya akan ditambahkan lagi menu baru jika Anda
mengaktifkan object tambahan.

4, Title Bar

Title bar merupakan bagian yang berada paling atas lembar Excel.
Grup, misalnya Tab Home terdiri atas grup Font, Alignment, Number dan Style.

5. Formula Bar, adalah baris yang digunakan untuk membuat rumus atau formula dapat
juga digunakan untuk melakukan pengeditan rumus.
6. Petunjuk Sel (Cell Pointer)

Untuk memindahkan penunjuk sel ke posisi yang baru dapat digunakan bantuan
mouse

Tombol Keterangan
' —* 1 Pindah satu sel ke kiri, kanan, atas atau bawah
Enter Pindah satu sel ke bawah
Home Pindah ke kolom A pada posisi baris yang aktif
Ctrl + Home | Pindah ke sel Al pada lembar kerja yang aktif

Gambar 3 : Petunjuk Sel (Cell Pointer)

Jika posisi sel berada diluar tampilan jendela, maka kita dapat menggunakan
fasilitas scrollbar, baik yang vertikal maupun yang horisontal untuk menjangkau
sel yang dimaksud.

7. Workshet, adalah lembar kerja Microsoft Excel. Setiap Anda pertama kali membuka
Excel, secara otomatis akan disediakan 3 buah worksheet atau sheet yang dapat Anda
gunakan.
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Dokumen yang Anda buat harus disimpan agar nantinya dapat dipanggil kembali. Langkah
menyimpan data tersebut adalah : File » Save. Selanjutnya kotak dialog save as akan

ditampilkan.

Yesterday
Ujian pkk
o

Last Week
H;

RAchman

MICROSOFT EXCEL
1 » LKP ENTER » MICAOSOFT £XCEL

Wy Documents

Save As: adalah tempat penyimpanan
Dokumen

Browse: adalah untuk mencari tempat
penyimpanan file

e :

Tempat Penyimpanan file
dapat kita tentukan
Contoh menyimpan pada
Documents, Localdisk D,

PR oy

Desktop

File Name: adalah nama
dokumen yang akan disimpan.
Contoh nama file “ Data Siswa”

Gambar 4 : Kotak Dialog Save AS
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Anda juga dapat menggunakan icon save ( E ) pada Quick Acces Toolbar, atau dengan
menekan shortcut keyboard CTRL + S.

Jika anda melakukan kesalahan dalam proses penyimpanan dan ingin menyimpan kembali,

maka Anda dapat melakukan perintah Save As, maka kotak dialog Save As akan ditampilkan

lagi.

Untuk membuka data yang telah tersimpan dengan cara : Klik File » open, selanjutnya akan
ditampilkan kotak dialog Open, tentukan folder penyimpanan dan nama file yang akan
dipanggil. Agar proses memanggil lebih cepat Anda juga dapat mengklik icon open ( )
atau menekan shortcut CTRL + O.
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Gambar 5 : Tampilan Worksheet

Keterangan:
1. Name Box, name box adalah nama yang menunjukan informasi sel yang sedang akif.

Contoh pada gambar di atas menunjukan informasi D6, artinya sel yang sedang aktif
adalah kolom D dan baris ke 6.

2. Column, ditunjukan dengan huruf mulai dari A hingga IV, jumlah kolom yang terdapat
dalam satu sheet adalah 256 kolom.

3. Row, (baris) ditunjukan dengan angka mulai dari 1 hingga 65.536 baris.

4. Cell Aktif, adalah posisi dimana Anda dapat memasukan data baik data angka, teks,
formula/rumus dan bahkan gambar.

5. Tab Sheet, adalah tombol untuk berpindah sheet serta melakukan pengaturan seperti
menghapus, menambah, sheet.
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Worksheet adalah lembar kerja Microsoft Excel, Anda dapat melakukan entry data, edit data,
membuat table, grafik serta membuat formula didalam worksheet tersebut.

Pengaturan Sheet:
1. Menambah Sheet

N

Menghapus Sheet
Mengganti Nama Sheet

w

N

. Mengatur ukuran kolom

ol

. Mengatur ukuran baris

S

Mengatur ukuran
Beberapa kolom
dan baris sekaligus

7. Menghapus Kolom/Baris

8. Menambah kolom/baris

9 | Modul Microsoft Excel

: klik icon Insert Worksheet ( ) ) yang terdapat pada tab
sheet.

. klik kanan pada sheet yang dihapus lalu pilih Delete.

: klik kanan pada sheet yang akan diganti namanya pilih
Rename.

. klik kolom yang akan diatur ukurannya kemudian klik di Nama
kolom sehingga pointer seperti gambar dibawah ini:

D + E

. klik baris yang akan diatur ukurannya kemudian klik di Nama
Baris sehingga pointer seperti gambar di atas.

. klik dan drag (blok) kolom yang akan diatur kemudian
klik Tab Home » Format pada Grup Cells »
Column Width. » Masukkan nilai yang Anda inginkan.

IC Row Height.

J K Fit Row Height lo

Visibility

Column width: |3

Hide & Unhide

Organize Sheets [ Ok ] [ Caneel I

Rename Sheet

—>

Gambar 6 : Mengatur ukuran kolom dan baris

: klik kanan pada kolom/baris yang akan dihapus » Delete »
Delete Entire Colomn/Delete Entire Row.

. klik kanan pada kolom/baris yang akan ditambah » Insert
» Insert Entire Colomn/Delete Entire Row.

Insert

_ 1 Shift cells right

Gambar 7 : Inset Entri Row
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Format cell adalah pengaturan pada suatu cell atau lebih. Pengaturan tersebut diantaranya
adalah: membuat table, mengatur format angka, mengatur perataan text dan lain
sebagainya. Untuk melakukan format cell terlebih dahulu Anda tampilkan kotak dialog format
cell, dengan cara sebagai berikut:

» Klik salah satu drop down list (") yang terdapat pada tab home.

» Atau Klik Tab Home » Format » Format Cells.

» Atau Klik Kanan pada cell pilih Format Cells.

» Atau tekan tombol shortcut CTRL + 1.

1. Number, menu ini digunakan untuk mengatur format angka pada suatu cell. Contohnya
pembuatan format mata uang pada suatu angka.
» Ketik data seperti dibawah ini

Tabel Kelas Biaya dan Discount

Kode Kelas Kelas Biaya

AOL Windows 100000
A02 MS Word 2007 200000
AD3 MS Excel 2007 200000
Ad4 MS Powerpoint 2007 150000
AO5 MS Publisher 100000

» Klik drop down list Number pada tab Home

» Pilih Accounting lalu tentukan Symbol yang akan digunakan (Rp) » OK
et — e

Norber | Algreent | Fork | Border | Rl Protacton |
Category,
General Sample
Humber M Word 2007
——— Decimsl places: |0 £
Tie: =
rea B —
B M
Etied i oy Tabel Kelas Biaya dan Discount
Enghsh (Caribbean) -
Kode Kelas Kelas Biaya
A01 Windows Rp  100.000
A2 MS Word 2007 Rp  200.000
line up the currency symbels n & column,
A03 MS Excel 2007 Rp  200.000
A4 MS Powerpoint 2007 Rp 150.000
(e ] [Lame || ADS MS Publisher Rp  100.000

mbar 8 Format Cell Number
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» Anda dapat juga melakukan klik pada icon (

sel.

= Text Alignment, digunakan untuk
mengatur perataan text.

3 ] c o € 3 5 H 1 3 3 L

Orientation, digunakan untuk
T s e r _ [} mengatur cara penulisan text
' e di dalam cell baik horizontal
| 4 maupun vertical

Text Control, digunakan untuk
mengatur text di dalam cell

diantaranya memberikan text
a wraping yaitu melipat kata
S L jika kolomnya tidak mencukupi

Gambar 9 : Format Cell Aligment

3. Font, menu font digunakan untuk melakukan pengaturan pada huruf (Font) di dalam
suatu sel.

Format Cells ==

Fonk: Fonk style: Size: |
Callbri Reqular 1
I Cambria (Headings) - |Regular ] -
T Calibri (Body) Ttalic 9 | '
TP Agency FB Bold 10
I plgerian Bold Iralic 11
B Avial 12
T Avial Black - 14 hd
Underfine: Color:
Hore v/ | I | [V Normal Fort
Effects Preview
Strikethrough
Superscript AaBbCcYyZz
Subseript

This s a TrueType fonk, The same Font will be used on both your printer and your
screen.

Gambar 10 : Format Cell Font
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Selain mengatur font dengan menggunakan Format Cells, Anda dapat juga mengatur
font langsung dengan klik pada Tab Home dan Grup Font.

Contoh: pembuatan table untuk dokumen

» Ketik data di bawah ini:

Tabel Kelas
Kode Kelas
AlL
Al2
AD3
Ao
ADS

Biaya dan Discount
Kelas

Windows

MS Word 2007

MS Excel 2007

MS Powerpoint 2007
MS Publisher

» Blok table tersebut.
» Klik drop down list Number pada tab Home

» Lakukan pengaturan seperti dibawah ini

T

Format Cells

Line
Stie:
None ===+

Automatic

buttons sbove.

Number | Alignment |

v

Fork Border Al | Protection

Pressts

Mone  Qutiine  [rside

- Border

a Text Text

=

a Text Text ‘
28 @ B

Biaya

The selected bordr style can be applisd by clicing the presets, praview disgram or the

100000
200000
200000
150000
100000

Border, menu border digunakan untuk membuat sebuah table dengan cara
memberikan garis pada gridlines worksheet.

Keterangan:

Untuk bagian outline pilih style
double line ( )
Untuk bagian inside pilih style
reqular (— )

Gambar 11 : Format Cell Border

» Hasil akhir table

Tabel Kelas Biaya dan Discount

Kode Kelas Kelas Biaya

AOL Windows Rp 100.000
AD2 MS Word 2007 Rp 200.000
AD3 MS Excel 2007 Rp  200.000
A4 NS Powerpoint 2007 Rp 150.000
A05 IS Publisher Rp 100.000

12 | Modul Microsoft Excel
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5. Fill, menu ini digunakan untuk memberi efek warna pada sel yang terpilih.

Format Cells i
“Number | Alignvent | Font | Border || Fil | | Protection |
Background Color: Patterm Color:
o Calor Automatic v
B EEEEEN Patterm Style:
|
]
|
mEE
EEEEEEEEN
EEEEEEEEERN
B | k- EER
il Effetts | | bore Colors,
Sample
=

Gambar 12 : Format Cell Fill
Hasil penggunaan fill pada sebuah table dapat dilihat pada contoh gambar dibawah ini:

Tabel Kelas Biaya Discount

Al Windows Rp 100.000
Al2 NS Word 2007 Rp 200.000
A3 MS Excel 2007 Rp 200.000
Al M5 Powerpoint 2007 Rp 150.000
A5 MS Publisher Ep 100.000

Selain menggunakan format cell » fill, Anda juga dapat menggunakan auto format untuk
mendesign sebuah table, dengan cara klik tab Home » Format As Table pada grup
style, lalu memilih tampilan yang Anda inginkan.

2 | nome

o : -

Gambar 13 : Auto Format

6. Protection, digunakan untuk mengunci atau menyembunyikan sel yang terpilih.
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Formula digunakan untuk mengkalkulasi nilai-nilai dalam suatu urutan. Sebuah formula dalam
Excel selalu didahului dengan lambang sama dengan (=). Setelah tanda sama dengan
maka Excel akan membacanya sebagai sebuah formula yang menjadi unsur-unsur untuk
dihitung yang mana dipisahkan oleh operator kalkulasi.
Operator dalam Excel dibagi menjadi empat macam, yaitu:
1. Operator Arithmetic
Operator ini digunakan untuk melakukan operasi dasar matematika seperti penambahan,
pengurangan, pembagian dan sebagainya:

A?ﬂﬁ:ﬁte(t)irc Fungsi Contoh
+ (Plus) Untuk operasi penjumlahan 3+3
- (Minus) Untuk operasi pengurangan 31
Untuk lambing nilai negatif -1
* (Asterik) Untuk operasi perkalian 3*3
/ (Forward) Untuk operasi pembagian 313
% (Percent) Untuk lambing persen 20%
A (Caret) Untuk operasi perpangkatan 32
2. Operator Comparasi (Pembanding)
Digunakan untuk membandingkan dua buah nilai
Operator Fungsi Contoh
Comparasi
= (equal) Sama dengan Al=B1
> (greater than) Lebih besar Al>B1
< (less than) Lebih kecil Al<B1
>=(greaterthanor | Lebih besar atau sama Al >=Bl
equal to) dengan
<=(less than or Lebih kecil atau sama Al<=Bl
equal to) dengan
<> (not equal to) | Tidak sama dengan Al<>B1

Dengan menggabungkan operator diatas akan menghasilkan nilai TRUE jika hasil proses
pembandingan benar, jika salah maka akan menghasilkan FALSE.

14 | Modul Microsoft Excel
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3. Operator Perbandingan Teks

Operator Teks Fungsi Contoh

& (ampersand) Menghubungkan atau “Anisa” & Nurul”
menggabungkan dua buah
teks.

4. Operator Referensi
Kombinasi dari beberapa sel untuk kalkulasi dengan operator berikut:
Operator Teks Fungsi Contoh
: (colon) Digunakan untuk B5:B15
penggabungan nama sel
dalam sebuah referensi
(range)
, (comma) atau; | Digunakan dalam operator | SUM(B5:B15;D5:D15)
penggabungan beberapa
referensi menjadi satu
(space/spasi) Operator Intersection, yang
menghasilkan sebuah
referensi dari perpotongan
dua referensi

STRUKTUR FUNGSI

Struktur Argument

> A /

o < -

=SUM(C7:C12)) |
SUM{numbesLfaafiber2qd |

Nama Fungsj ] \Argument Tooltip
Gambar 14 : Struktur Fungsi
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Keterangan:

Struktur, susunan sebuah fungsi dimulai dari tanda sama dengan (=) diikuti nama fungsi,
kemudian kurung buka ((), argument untuk fungsi dipisah dengan tanda koma atau titik
koma dan diakhiri dengan kurung tutup.

Nama Fungsi, nama fungsi yang digunakan, agar lebih cepat Anda dapat menggunakan
shortcut keyboard SHIFT +F3

Argument, dapat berupa angka, teks, nilai logika seperti TRUE atau FALSE.

Argument Tooltip, sebuah tampilan dimana kita dapat melihat struktur fungsi.

FUNGSI-FUNGSI DASAR

Fungsi Keterangan

SUM Mencari jumlah pada range dalam beberapa sel

MIN Menghitung nilai terendah pada range dalam beberapa sel

MAX Menghitung nilai tertinggi pada range dalam beberapa sel

AVERAGE Menghitung nilai rata-rata pada range dalam beberapa sel

LEFT Mengambil sebagian teks dari kiri sebanyak nilai n (dimana n
adalah jumlah teks yang akan diambil)

RIGHT Mengambil sebagian teks dari kanan sebanyak nilai n (dimana n
adalah jumlah teks yang akan diambil)

MID Mengambil sebagian karakter dari tengah mulai dari m sebanyak n
(dimana m adalah awal teks yang akan diambil dan n adalah
jumlah teks yang akan diambil)

Contohnya: =MID(“MICROSOFT EXCEL";11;6) menghasilkan
OFFICE
FUNGSI IF

Fungsi IF adalah sebuah fungsi logika yang menghasilkan nilai benar apabila hasil
pengujian pada logical test bernilai benar, selain itu akan menghasilkan nilai salah. Bentuk
penulisannya adalah sebagai berikut; IF(logical_test;value_if true;value_if fals)

Locigal test adalah suatu nilai atau ekspresi yang diuji dapat menghasilkan nilai benar
atau salah, dalam membuat locical test selalu menggunakan operator logika seperti
=><, >=, <=, ataupun <>.

Value_if _true adalah nilai yang akan diisikan jika dalam logical_test bernilai benar
Value_if_fals adalah nilai yang akan diisikan jika dalam logical_test bernilai salah.

Contoh soal:
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PT ANUGERAH SEJAHTERA melaksanakan seleksi penerimaan karyawan dengan
melaksanakan test tertulis, personalia mengambil keputusan untuk memanggil karyawan
yang nilai testnya diatas atau sama dengan 70 untuk mengikuti test wawancara.

Berikut daftar peserta test tertulis dan nilai rata-rata peserta test

A B = D

1 DAFTAR HASIL TEST SELEKSI

2 PENERIMAAN KARYAWAN

3 PT ANUGERAH SEJAHTERA

4

© NO _ NAMAPESERTA NILAITEST KETERANGAN
6 1[YULIAMINGSIH 75
7 2[AYU DYAH 85
8 3RINAWATI 65
9 AISUSAN VERONICA 68
10 S[SANTA VERONICA 68
11 G6[ARIANDI SOFIAN 70
12 FISURIYANSYAH 65
13 [N RAFII 75
14 S(AMDHIRA 85
15 101K, FAUZAN 65
16 =

Penyelesaian
e Pada kolom D6 ketikan formula seperti contoh dibawah ini

A B C D E F
1 DAFTAR HASIL TEST SELEKSI
Z PENERIMAAN KARYAWAN
3 PT ANUGERAH SEJAHTERA
a
Mo wemese st e
6 1[YULIANINGSIH 75| =IF(C6>=70;"LULUS";"TIDAK LULUS")
7 2|AYU DYAH 85
8 3[RINAWATI 63
9 A(SUSAN VERONICA 68
10 S[SANTA VERONICA 68
11 GlARIANDI SOFIAN 70
12 T[SURIYANSYAH 65
13 8|M. RAFI 75
14 S[ANDHIRA 85
15 10|M. FAUZAN 63

e
- e

o Jika sudah selesai copy kan formula tersebut hingga ke sel D15
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Chart digunakan untuk menunjukan sebuah nilai yang selalu berubah dalam satu periode,
cara menyisipkan chart dalam excel adalah sebagai berikut:
1. Persiapkan data sumber

1 Star Phone

2 Grafik Penjualan Handphone

3 Periode Januari - Juni 2007

4

5 !

] Ben Q

, ‘ Nekia ]Saw Ericson| Samsung | Motorola Siemens Le
& Januari 7 5 3 1 2 1
9 Februari 8 3 2 2 2 1
10 Maret 9 6 4 1 3 2
u oAl 7 7 3 |2 2 2
12 [ Mei 9 9 5 2 1 2
13 Juni 10 5 5 2 3 1

2. Drag table tersebut
3. Klik tab Insert » pilih column pada group charts
= | I I-' |l'I'
1?2 | A I -
Recormmended M‘ IIII‘ I~ PivotChart ]

Charts L ARG tap ~

Charts ra Tours

Gambar 15 : Group Chart

4. Pilih salah satu dari pilihan yang disediakan, sehingga menghasilkan chart seperti contoh
dibawah ini:

12

10

® Nokia
8

W Sany Ericson

W Samsung

m Motorola

mBen Q Siemens

=G

Januari Februari Maret April Mei Juni

Gambar 16 : Hasil Chart
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5. Selanjutnya Anda dapat menentukan Style chart tersebut dengan memilih Tab Design
yang secara otomatis akan aktif pada saat Anda mengaktitkan chart tersebut.

iy LLL

b - mm

Gambar 15 : Tab Design

6. Anda juga dapat menambahkan atribut seperti judul, memberikan label, mengatur

warna diagram/chart yang secara otomatis juga akan aktif pada saat chart tersebut
diaktifkan.

[
IR W7 e
fdd Chart Quick | Change

Elernent~ Layout~  Colors -
Chart Layouts

Gambar 16 : Chart Layout

7. Terakhir, Anda juga dapat mengatur item-item yang ada didalam chart tersebut, seperti
mengganti warna batang, gridlines, background dan sebagainya dengan
menggunakan tab Format yang secara otomatis akan aktif mengikuti tab design, dan tab
layout.

artriulas Data Resvien i e Design Forrnat ' Tell me what you want to

22 Shape Fill -
[Atu:] [Ahc] [Ahc} &b &b Abc Abc |- L Shape Outline -

T O Shape Effects -
Shape Styles P

Gambar 17 : Galleri Format Design
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DATA SORT (Mengurutkan Data)

Sort digunakan untuk mengurutkan data baik secara ascending (naik) maupun descending
(turun)

S X cut ) . I o= . Em . | B

SO Calibi 1 - A A ©- [ Wi Tex Genersl @

P‘.m ¥ Format Painter BIu-E-O-A- SE=|E% BVugacns - F- %0 W3 F‘i::‘ﬂ‘i‘;‘:"‘;l. F?F’:Cla:-a’
Clipboard ) Font n Alignment = Number )

Al I 2 No Urut

4| a H | 1 1 K L

1

2 1|Sri Rahayu 1

3 2|Ramadhani Rahman 2

) 3|Raja Rejeki 1

| 4|Rudy Almanar g

6 5[Ricky Harun 1

7 6[Thomas 4

8 7[Tomy Kurniawan &

9 8|Endang 5

10 =

Langkah mengurutkan suatu data adalah :

1. Blok seluruh data yang ingin diurutkan

2. Pilih tab Data - Kiik icon Sort = |

3. Klik 2] | untuk pengurutan Ascending (diurutkan berdasarkan dari kecil ke yang
besar)

4. Klik @ untuk pengurutan Descending (diurutkan berdasarkan dari besar ke yang
kecil)

5. Ok
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DATA FILTER (Menyaring Data)
Filter berguna untuk menyaring data agar mudah dalam mencari atau mengkategorikan atau
juga mengelompokkan suatu data.

Langkah menyaring suatu data adalah :
Blok seluruh data dalam tabel

Pilih tab Data —Klik icon Filter ¥

Klik icon tanda filter drop-down |~

Pilih urutan data yang akan ditampilkan
Ok

ak~wn e

- )
F#I 7
e BiCenter » T0- 95 3 | %43 8 Conditional Formatas

Forratting = Tasle

D3 N f =IF(C3=1;"Top Room";IF(C3=2; "Executive"; IF{C3=3; "Business";IF (C3=4"President™;"Suite"))))
A B C D E F G H 1
i No Urut| Nama T sl Kode Type | Type Kamar Fasilitas
3 1[Sri Rahayu £l 5 Single Kulkas, ACSplit, TV
4 2[Ramadhani 5 Single Kulkas, AC, TV
5 3[Raia Rejeki 5] Double Kulkas, ACSplit, TW
& 4|Rudy Almar D Double Kulkas, AC, TV
7 S|[Ricky Harun Tect Filts F Family. Kulkas, AC Split, TV
8 &|Thomas . 5 F Family AC TV
] 7| Tomy Kurnii T 5P |specal aC
10 |Endang 1usiness 5 Single AC
11 | Executive
] President.
12
13
14
15
15
1; Ce=Jls

19
20

6. Untuk menghilangkan tanda klik kembali icon Filter

- SwnpTes . =
) Pr- SewnpTe al ?El B
e DA E == = ElMese&Ceoer - - 9% s |43 8 Conditional Formatas
s D F »- A = | Bl wegeacaier - | - % 2 |58 | 0 e
Font n Agrment ® Numoer
1 fe
A E c 2] E F G H I
1 NoUr- Nama Tamu - | Kode Kam: - | Nama Kama 7| Kode Tyg - | Type Kami - Fasilitas
3 1/5r Rahayu 1 Top Reom S Single kulkas, AC Split, TV,
5 3|Raja Rejeki 1 Top Room D Double Kulkas, AC Split, TV
7 5[Ricky Harun 1 Top Room F Family Kulkas, AC Split, TV
1
12

Gambar 18 : Hasil akhir filter
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Mencetak lembar kerja merupakan hal penting yang harus kita lakukan, agar apa yang telah
kita olah di Excel dapat dibuat hardcopynya, apakah sebagai laporan atau arsipnya saja.
Langkah — langkah yang dapat kita lakukan sebelum mencetak lembar kerja adalah sebagai
berikut :

e Pengaturan Set Up Kertas dan Margin

P

Klik Tab Page Layout » klik Drop Down List Page Layout ( ) sehingga tampil
kotak dialog page setup.
Page Setup TIX
| Margins | Header /Footer | Sheet |
Crientation
1@ Paortrait I I Landscape
Scaling
© adjust to: 100 [ % normal size Orientasi Kertas
11 Fik to: 1 page(s) wide by |1 kall
Paper size: aq |
Print quality: | 300 dpi |
First page number: | Auto Ukuran kertas
Erink... ] [Print Preview] ’ Options. .. ]
[ Ok ] [ Cancel ]

Gambar 19 : Tampilan Page Setup
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» Print area : menentukan area yang dicetak.

» Print titles : menentukan judul yang tercetak tiap halaman.
» Rows to repeat at top : untuk menentukan beberapa baris yang akan
tercetak

pada bagian paling atas pada tiap halaman.

» Columns to repeat at left : menentukan beberapa kolom yang akan tercetak
pada bagian paling kiri tiap halaman.

» Gridlines > untuk mencetak garis grid(pembatas sel).

» Row and column headings  : untuk mencetak nomor baris dan nomor kolom.

» Draft quality : untuk mencetak dalam kualitas draft.
» Page order : untuk menentukan arah pemisahan halaman
» Header/footer : adalah untuk menentukan bagian margin atas

bawah tiap halaman.
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Klik print preview
print preview

o |

Gambar 20 : Tampilan Print Preview

Klik icon Print ( 5 ) selanjutnya akan ditampilkan kotak dialog print

Jumlah S = i
halaman = el -
yang akan —_—

Gambar 21 : Kotak dialog Print
Klik OK untuk mencetak atau Kiik icon

Jumlah lembar yang akan
di cetak

Print / Cetak

Nama Printer yang

akan digunakan

Printer __ Properties  untuk
mengedit halaman yang akan
di cetak, seperti pengeditan,
Kualitas  cetakan, warna
hitam/putih  dan  halaman
terbalik (Reverse Order).

e Anda juga dapat melakukan klik pada icon Quick Print ( ) pada Quick Acces Toolbar
untuk melakukan cetak cepat tanpa melalui pengaturan seperti pada point di atas.
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Apabila Anda akan mengakhiri pekerjaan Anda maka Anda dapat menutup aplikasi
dengan mengklik tombol Close ( - ), atau Exit Word pada Office Button, atau
dengan menekan shortcut CTRL + W.

Apabila ada data yang masih belum tersimpan, maka akan muncul kotak dialog
seperti dibawah ini :

Microsoft Office Excel

l Yes ] [ Mo l [ Cancel ]

Gambar 22 : Kotak dialog Save

1. Pilih Yes untuk menyimpan dokumen
2. Pilih No untuk keluar tanpa menyimpan

3. Pilih Cancel untuk batal keluar dan melanjutkan bekerja
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